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Instrument Wavelength Max Power Emitted 

7601-C 1515 nm – 1570 nm < 5 mW 

7601-CL 1520 nm – 1630 nm < 5 mW 

7601-O 1260 nm – 1360 nm < 5 mW 

  
 

 

Many regions prohibit the disposal of WEEE (Waste 
Electrical and Electronic Equipment) in the normal 
waste stream, to comply with the Restriction of 
Hazardous Substances (RoHS) released into the 
environment. Please contact your local waste 
authority for instructions on proper recycling of the 
electronic product(s) described in this User Guide. 
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1 Safety 

The advisory words Danger, Warning and Caution used in this manual identify the level of hazard 

that may be encountered by the user.  

• DANGER means if the danger is not avoided, it will cause death or serious injury.  

 • WARNING means if the warning is not heeded, it can cause death or serious injury.  

 • CAUTION means if the precaution is not taken, it may cause minor or moderate injury. 

 

 Warning 

The protection provided by the equipment may be impaired if the equipment is used in a 
manner not specified by the manufacturer, resulting in serious injury or death. 

The power cord is the main electrical disconnect for this equipment. If it is necessary to 
ensure no power to the unit, remove the power cord. 

The use of controls, adjustments, performance, or procedures other than those specified 
herein may result in hazardous laser radiation exposure and one or more safety protections 
may be impaired or rendered ineffective.  
 

 Attention 

La protection fournie par l'équipement peut être compromise si l'équipement est utilisé 
d'une manière non spécifiée par le fabricant, entraînant des blessures graves ou la mort. 

Le cordon d'alimentation est le principal disjoncteur électrique de cet équipement. S'il est 
nécessaire de ne pas mettre l'appareil hors tension, retirez le cordon d'alimentation. 

L'utilisation de commandes, d'ajustements, de performances ou de procédures autres que 
celles spécifiées ici peut entraîner une exposition dangereuse au rayonnement laser et une 
ou plusieurs protections de sécurité peuvent être altérées ou rendues inefficaces. 
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2 Technical Support 

If you have concerns with or questions about the information contained in this document, contact 

our technical support staff at: support.lunainc.com  

http://support.lunainc.com/
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3 Overview and Setup  

The Luna LWA 7600 is a fast and simple-to-use analyzer for passive optical components and 

modules. The Luna LWA 7600 extends the industry-leading optical frequency domain reflectometry 

(OFDR) platform from Luna Innovations to manufacturing test and quality control applications. 

Unlike traditional passive component testers, the Luna LWA 7600 measures and analyzes the 

Insertion Loss (IL) and Return Loss (RL) distribution, as well as length, working in either reflection or 

transmission. The Luna LWA 7600 features extremely high sensitivity, 20 μm spatial sampling 

resolution, and very fast scanning for high test throughput. 

This user’s guide covers how to set up and use the application software.  Please refer to the Luna 

LWA 7600 Setup Guide for information regarding the proper methods of setting up and maintaining 

the hardware. 
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4 User Interface 

Let us take a tour of the application’s User Interface (UI). The tour will start with an introduction to 

the UI layout, then further explains each UI components which include Delay Plot, Spectral Plot, 

Event Table, Measurement Control and Information displays. 

The UI supports up to four traces being displayed at a time. The first trace is the data actively being 

measured. The other three traces can be copied from another trace or a loaded data file saved from 

an earlier session. 

4.1 UI Layout Overview 

After you power on the system and start the Luna LWA 7600 software on the controller PC, the 

application UI screen will appear on the PC screen. The system will initialize, then launch the 

hardware in reflection mode and display one measurement result on the screen. The image below 

(Figure 4-1) is an illustration of a typical UI screen layout with all optional displays turned on for a 

reflection measurement (for a transmission measurement, UI layout is the same except for the 

omitting of all elements related to return loss).  

The upper section of UI screen is for the display of Measurement Controls. 

The lower section of UI screen is the Delay Plot (UPPER LEFT side) along with an optional Spectral 

Plot (LOWER LEFT side) and an optional Event Table (RIGHT side).  The Delay Plot would be scaled to 

take up the whole lower section area if the optional displays are turned off (which is the default 

when the system is just powered up). 

Each of the above UI components is further explained in the following titled sections, respectively. 
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Figure 4-1 Screen Layout 

 

Figure 4-2 Multiple Traces 
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4.1.1 Status 

The system Status is indicated in the top left corner of the user interface. The status displays the 

current state of the system including message regarding system startup, ready state, measuring 

state, and error states. 

4.1.2 Measure 

On startup, the user interface will display the latest measurement. Click the measure button 

 to perform a new single measurement. Check the Continuous checkbox to perform 

continuous measurements. Click the Measure button to start the continuous measurement. This will 

change the Measure button to display “Stop” . Click the Stop button to stop 

the measurements. 

4.1.3 Trace Settings 

The UI supports up to four traces to be displayed at a given time as shown in Figure 4-2. The left-

handed pointed arrow  to the upper right of the Trace Legend allows for the minimizing of the 

legend. To maximize the Trace Legend, click the right arrow that is next to the y-axis of the plot . 

The first trace is the current measurement . The other three traces can be a loaded OFDR file  

or a copy of another trace . The Trace Legend as shown in Figure 4-3, allows the user to control 

the aspects of the traces. Each trace has a checkbox  to display or not display that specific trace. 

 

Figure 4-3 Trace Legend 

Selecting the Color Square allows the user to change the current color of that specific trace. This 

will bring up a color dialog as shown in Figure 4-4. The associated icon will also change to the 

selected color for easier reference. 
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Figure 4-4 Color Dialog 

Selecting the Copy Trace Button  copies the current trace into an empty trace. Selecting the Clear 

Trace Button  clears a trace. This is useful in case there are no open traces, or a trace is no longer 

needed. 

Hovering over the Gear Button displays settings related to the associated trace as shown in 

Figure 4-5 

 

Figure 4-5 Acquisition Settings 

The Gear Button  opens the Trace Dialog as shown in Figure 4-6. This dialog provides the 

operating settings for the trace and allows the user to change certain data parameters. 
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Figure 4-6 Trace Settings 

Processing Parameters 

• Group Index – allows the user to specify the group index of refraction (range: 1 – 4). 

• Gaussian Filter – if checked, a Gaussian filter is applied to the data to smooth out the graph. 

This is turned on by default. 

• Filter Size – sets the Gaussian Filter width in display units which is meters by default, options 

are 0.00016m, 0.00032m, 0.00064m, 0.00128m, 0.00256m, 0.00512m and 0.01024m 

(default). 

 

Event Options 

• Min Location and Max Location – allows the user to specify the length/location range of 

events reported in the Event Table. 

• RL Threshold and IL Threshold – allows the user to specify threshold value for RL or IL for its 

qualified as RL or IL events and to be reported in the Event Table. 

4.1.4 Turn Spectral Plot Display On/Off 

Check the Spectral Plot Checkbox  to display the Spectral Plot. The Spectral Plot is not 

displayed by default after you first open the application. When the Spectral Plot checkbox is 

checked, the Cursor Type  will change to Spectral automatically. Uncheck the 

Spectral Plot checkbox to hide the Spectral Plot. See section “4.3 Spectral Plot” for more 

information. 

4.1.5 Turn Event Table Display On/Off 

Check the Events Checkbox  to display the Event Table. The Event Table is not displayed by 

default after you first open the application.  Uncheck the Events Checkbox to hide the Events Table. 

See section “4.4 Event Table” for more information. 

 



 
  

LWA 7600 

 
 

LWA 7600 User’s Guide     Rev002             Page 9 

 

 

4.2 Delay Plot 

When you first open the application, the UI screen appears with the Delay Plot as shown in Figure 

4-7.  The Delay Plot screen displays acquired measurements in the Time Delay Domain (reflection 

amplitude vs time of flight, or reflection amplitude vs length).  

The plot x-axis unit can be displayed in one of the following five options: m, mm, inch, ft or ns. 

 

Figure 4-7 Delay Plot 

The Delay Plot Screen allows the user to change the Cursor Type to one of four possible values by 

choosing a Cursor Type selection in the upper right area of the plot: 

 

• None – Only the graph of the acquired data is displayed. 

• Single – A single vertical cursor is shown that allows for RL and IL measurements to be 

made. 

• Vertical – Two vertical cursors are shown that can be used to make length measurements. 

• Horizontal – Two horizontal cursors are shown that can be used to make IL measurements 

and compare the reflectivity of various features in the measurement. 
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• Spectral – A single vertical cursor allows users to select a windowed range in the Delay Plot 

and then viewing a calculated metric (e.g., return loss, group delay) in Spectral Plot; it is only 

available for selection when the Spectral Plot Checkbox is checked. 

Cursors can be moved by dragging them across the screen by using a mouse. When the cursors are 

selected and are being moved, they will change color to black (The cursor turns black when you 

press it, indicating that it can be moved). Clicking once on the cursor will cause it to snap to the 

highest point within its highlighted zone. 

4.2.1 Plot Navigation 

The plots shown in the LUNA LWA 7600 user interface can all be manipulated through mouse or 

touchpad actions on the laptop PC. 

Panning – The plot can be panned over the X and Y axes by pressing and dragging at any point 

within the plot. 

Zooming – The plot can be zoomed using a two-finger pinch or expanding motion at any point 

within the plot on touchpad or scrolling wheel on a mouse. 

Constrained Panning or Zoom – It is possible to constrain the panning and zooming to one of 

the two axes by first left clicking on the desired axis. It will turn blue while panning and zooming 

is constrained. 

Plot Rescaling – Double click on an axis to scale it to fit all data in the range. 

Rescale Plot – Click on the Rescale Plot button  on the lower left of the plot to rescale the 

entire plot to fit the window. 

4.2.2 Single Cursor 

The single cursor view provides a single vertical cursor with integration regions for measurement of 

both the RL and IL across an event as shown in Figure 4-8. The region with red shadowing is 

integrated to provide an RL measurement. The two regions with grey shadowing are used to 

compute the IL. The corresponding RL Width and IL Width can be changed in Measurement Settings. 

See section “4.5.3.2 Measurement Settings.” Data will be displayed in the upper right for all visible 

traces. 
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Figure 4-8 Single Cursor View 

4.2.3 Vertical Cursor 

The vertical cursor view provides two cursors that can be used to measure the length between two 

events or measure the IL over any distance as shown in Figure 4-9. The RL, position, and IL 

information is shown in the upper right area of the plot, under the Cursor Type selection. Data is 

shown for any visible trace. 

 

Figure 4-9 Vertical Cursor View  
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4.2.4 Horizontal Cursors 

The horizontal cursors are used to compare the amplitude of two events in the data as shown in 

Figure 4-10. 

 

Figure 4-10 Horizontal Cursor View 

It is important to remember that the amplitude data can be shown with varying levels of filtering 

which may make reflection peaks look smaller than they truly are. 

4.3 Spectral Plot  

4.3.1 Spectral Plot Overview 

When “Spectral Plot” option is enabled by checking the Spectral Plot checkbox  in the 

plot legend. When enabled, a single vertical Spectral Cursor is displayed in the upper Delay Plot. The 

calculated Spectral Loss and/or Group Delay of the given set of data (defined by the Spectral Cursor) 

is displayed as a function of optical wavelength in the lower Spectral Plot as shown in Figure 4-11. 
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Figure 4-11 Spectral Plot 

4.3.2 Spectral Cursor 

The cursor is only available for selection when Spectral Plot option is checked. The single vertical 

cursor is used to select a windowed range in the Delay Plot and then viewing a calculated metric 

(e.g., return loss, group delay) in Spectral Plot. 

4.3.3 Operations on Spectral Plot 

Manipulating the Spectral Cursor selects the range of Time Delay Domain data used to compute the 

spectral loss and group delay. The location of the Spectral Cursor data selection range in the Delay 

Plot can be changed by moving the cursor to different locations in the plot. The width of the data 

selection range can be change by changing the Spectral Cursor width setting as described in section 

“4.5.3.2 Measurement Settings”. 

In viewing the Spectral Plot (like it in the Delay Plot), the user has options of utilizing several types of 

cursors to analyze the plot data. The application allows the user to change the Cursor Type of the 

Spectral Plot to one of three possible values: 

 

• None – Only the graph of the acquired data is displayed, no characteristics of the data are 

shown. 
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• Vertical – using two vertical cursors, displays the location at each cursor and the difference 

between them. 

• Horizontal – using two horizontal cursors, displays the amplitude at each cursor location along 

with the difference between them. 

Selecting the Color Square next to Return Loss or Group Delay allows the user to change the color of 

that trace. This will bring up a color dialog as shown in Figure 4-4. 

4.3.4 Cursors on the Spectral Plot 

When using Vertical or Horizontal cursors on the Spectral Plot, the values shown in the cursor 

readout depend on which traces are enabled by the Return Loss and Group Delay checkboxes in the 

spectral plot legend. 

Vertical Cursors - Two vertical cursors (Solid and Dashes) are placed on the Spectral Plot as shown in 

Figure 4-12. For each cursor, the readout shows the wavelength, the corresponding Return Loss 

(when Return Loss is checked), and the corresponding Group Delay (when Group Delay is checked). 

The Diff value is the wavelength difference between the two cursors, and the IL value is the 

Insertion Loss between the cursor locations. 

 

Figure 4-12 Vertical Cursors on Spectral Plot 

Horizontal Cursors - Two horizontal cursors (Solid and Dashes) are placed on the Spectral Plot. The 

readout shows the y-axis value at each cursor and the difference (Diff) between them. 

4.4 Event Table  

The Event Table of the Luna LWA 7600 software displays the applicable return loss (RL) and insertion 

loss (IL) events detected in the Time Delay Domain and gives location, return loss, and insertion loss 

data for those events as show in Figure 4-13. 
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Figure 4-13 Event Table 

The drop-down list above the Events Table allows for choosing between the different traces as 

shown below. 

 

The Lightwave Analyzer can display an Event Table showing the most significant return loss and 

insertion loss events found in the current measurement. 

4.4.1 Event Marks in the Delay Plot 

You can check/enable the “Show Event Markers in Plot” checkbox to show vertical markers on all 

event locations as show in Figure 4-14. 
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Figure 4-14 Show Event Markers in Plot 

4.4.2 Event Distances 

You can check/enable the "Show Event Distances" checkbox to show relative distances from the first 

event as shown in Figure 4-15. 

 

Figure 4-15 Show Event Distances 

Clicking an individual event draws a marker at that event location and highlights the event that is 

selected as shown in Figure 4-16. The distances are updated relative to the event that was selected. 

Clicking the event again removes the marker. If you are using Single, or Vertical cursors, clicking an 

Event table entry snaps the closest cursor to that event location. 
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Figure 4-16 Clicking an event 

Double clicking an entry in the event table zooms the plot to that event's location as shown in Figure 

4-17. In the example, event 2 was double clicked. 

 

Figure 4-17 Double clicking an event 
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4.5 Menu 

4.5.1 Overview 

Open the menu by clicking the three bars  on the left top side of the user interface as shown in 

Figure 4-18. This will open the menu to perform file operations, settings, configuration 

management, help, and exiting the application. 

 

  

 

Figure 4-18 Menu 

The following sections describe each menu item in detail. 

4.5.2 File Operations 

4.5.2.1 File Dialog 

In version 3.1.0, a new File Dialog was introduced as shown in Figure 4-19. The file dialog is used to 

manage measurement files. Use the file dialog to navigate the files system, open measurement files, 

save measurement and TSV files, and delete measurement and TSV files. 
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Figure 4-19 File Dialog 

To navigate to a parent directory, click the up arrow  next to the current directory name. To 

navigate to a child directory, click any of the directory names under the Directory list.  

  

Under the directory names, it is possible to navigate to a different drive on the system. To create a 

new directory, click on the create directory icon . Each column may be sorted by clicking on the 

column header. To delete a file, click on the red trash can  to the right of the file list. The File filter 

shows what is being filtered in the file list. This field is disabled since only .ofdr and .tsv files are 

supported. 
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4.5.2.2 Open 

 

To open a measurement file, select File->Open to display the File Dialog as shown in Figure 4-19. 

Select the file which will be highlighted in blue and click the Open button to open the file. The file 

will be loaded in the first available trace as shown in Figure 4-20. In this example, “LiveJumper” was 

loaded in the second available trace and the plot was updated to display the “LiveJumper” 

measurement. See section “4.1.3 Trace Settings” on how to manage traces that are loaded. 

 

Figure 4-20 Loaded Trace File 

4.5.2.3 Save 

 

To save a measurement file and/or a TSV data file, select File->Save to display the File Dialog as 

shown in Figure 4-21. Type in a new file name or select an existing file name to overwrite. The file 

name will be update with “.ofdr” for a Measurement file and “.tsv” for a TSV data file. The TSV file is 

a tab delimited spreadsheet file containing measurement data. 
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Figure 4-21 File Save Dialog 

To save a measurement file, select the Measurement File checkbox . To save a 

TSV File. Select the TSV Data File checkbox . For the TSV Data File, there are several 

options: Delay Domain Plot result, Spectral Domain Plot result and Events result. There is also an 

ability to specify a subsection of the Delay Domain Data to be saved in the TSV Data File by lcicking 

the Save Segment and specifying the Start and End Segment. These options are shown in Figure 

4-21.  

 

Figure 4-22 TSV Data File Options 

If there is more than one trace, select the trace to be saved using the Select trace dropdown box as 

show in Figure 4-23. 
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Figure 4-23 Selecting Trace to be Saved 

 

4.5.3 Settings 

4.5.3.1 Acquisition Settings 

 

Select Settings->Acquisition Settings to change the acquisition settings on the instrument. Selecting 

Acquisition Settings displays the Acquisition Settings Dialog as shown in Figure 4-24. 

  

Figure 4-24 Acquisition Settings Dialog 

Select the Acquisition Type by selecting either Reflection or Transmission from the Acquisition Type 

Combo Box. 

Change the Acquisition Range by selecting the desired acquisition range from the Range Combo Box. 

The current available acquisition ranges in meters are: 20, 50, 100, 200, 500, 1000. These are based 

on features that have been licensed. The range values are based on the display units selected. 

The Acquisition Focus specifies a reference point near a peak that is used to optimize the data 

around that peak. The Acquisition Focus is not enabled for the ranges less than 50m. Specify the 

focus point by typing the value in the field. The value is in the current display units. 

4.5.3.2 Measurement Settings 
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Select Settings->Measurement Settings to change settings while viewing and interacting with the 

displayed plots. Selecting Measurement Settings displays the Measurement Settings Dialog as 

shown in Figure 4-25. 

 

Figure 4-25 Measurement Settings Dialog 

Selecting the Units changes the current display units including the delay plot x-axis. The default is 

meters (m). The system currently supports meters (m), millimeters (mm), inches (in), feet (ft) and 

nanoseconds (ns). 

The RL Width and IL Width changes the width of the integration regions that are used for return loss 

and insertion loss measurements. In the Delay Plot, the single cursor view provides a single vertical 

cursor with integrated regions for measuring both the RL and IL across an event. The region with red 

highlighting is integrated to provide a RL measurement. The two regions with grey highlighting are 

used to compute the IL. See section “4.2.2 Single Cursor.” 

The Spectral Cursor width specifies the data selection range of the spectral cursor if the spectral 

cursor plot is enabled. See section “4.3.2 Spectral Cursor”. 

4.5.3.3 Calibration Settings 

 

The instrument no longer needs to be calibrated every time the instrument is started. The 

instrument should be recalibrated as needed. To recalibrate the instrument, select Settings-

>Calibration Settings. Select Calibration Settings will display the Calibration Settings Dialog as shown 

in Figure 4-26. 

The Calibration Settings dialog contains two calibrations: the Polarization Balance Calibration and 

the Acquisition Range Calibration. For each, the dialog displays the date of the current calibration 

and the date of the factory calibration. 
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Figure 4-26 Calibration Settings Dialog 

A new system delivered from Luna will be factory calibrated. To calibrate, click on the Calibrate 

button . To restore the factory calibration, click on the Restore Factory 

Calibration button . When calibrating, it is best to wait for approximately 15 

minutes after turning on the instrument so that the instrument has time to warm up. 

Polarization Balance Calibration: The Polarization Balance Calibration measures the instrument's 

internal DC reference levels. Disconnect everything from the front panel before running it. This 

calibration is performed once and persists across instrument restarts. Running the Polarization 

Balance Calibration deletes any existing Acquisition Range calibrations. Each acquisition range in use 

must then be recalibrated. 

Acquisition Range Calibration: The Acquisition Range Calibration is performed separately for each 

acquisition range. Connect the Luna-supplied transmission calibration jumper before running this 

calibration. The Acquisition Range Calibration can be run only after a Polarization Balance 

Calibration is in place. 

NOTE: It is highly recommended to update the calibrations for the following: 

• Once a new instrument is received. 

• Any time the instrument is moved. 

• When the ambient temperature changes approximately ±2°C (3.5°F). 

4.5.4 Configuration 

System configuration can be saved, updated, or deleted through the configuration menus. A default 

configuration can be set to be used on system startup. The following configurations can be saved: 

• Display Units 

• Group Index 

• RL and IL Width 
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• Min and Max Event Locations 

• RL and IL Threshold 

• Apply Gaussian filter and Gaussian filter width 

• Spectral Cursor Width 

4.5.4.1 Load Configuration 

 

Selecting Configuration->Load Configuration display the Load Configuration Dialog as shown in 

Figure 4-27. 

 

Figure 4-27 Load Configuration Dialog 

Load a previously saved configuration by selecting the configuration from the combo box 

 and clicking “Ok”. 

4.5.4.2 Save Configuration 
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Selecting Configuration->Save Configuration displays the Save Configuration Dialog as shown in 

Figure 4-28. 

 

Figure 4-28 Save Configuration Dialog 

Saving a configuration saves the Measurement Options currently in use with the name specified in 

the Save Configuration Dialog. If the name already exists, a prompt will appear asking if it is okay to 

overwrite the previously saved configuration. 

 

4.5.4.3 Default Configuration 

 

Selecting Configuration->Default Configuration displays the Default Configuration Dialog as shown in 

Figure 4-29. 

 

Figure 4-29 Default Configuration Dialog 

The Default Configuration sets the configuration that the system will use on startup. If there is a 

default configuration already set, the name will be displayed in the “Current Default Configuration”. 

Select the default configuration from the comb box . To clear the default 

configuration, select the No Default button . 

4.5.4.4 Delete Configuration 
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Selecting Configuration->Delete Configuration displays the Delete Configuration Dialog as shown in 

Figure 4-30. 

 

Figure 4-30 Delete Configuration Dialog 

To delete one or more saved configurations, select the configurations to be deleted or check Select 

All  to select all the configurations. Click the red trash can  to delete the selected 

configurations. A prompt will appear to confirm the deletion. 

4.5.5 Help 

4.5.5.1 Documentation 

Select Help->Documentation to view system documentation and help as shown in Figure 4-31. These 

help documents can be accessed directly from the LWA 7600 software: 

• What’s New: Displays a list of the changes made for each version of the software. 

• User Guide: Matching version of the LWA 7600 User’s Guide (this document). 

• Setup Guide: Instructions for how to set up the LWA 7600. 

 

Figure 4-31 Help Documentation 

4.5.5.2 Update Feature Keys 
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Click Help->Update Feature Keys to update the software with optionally purchased features. Once 

the file dialog is displayed, select the Luna provided feature key update file. The LWA software must 

be restarted after updating the feature keys on the instrument. 

4.5.5.3 About 

 

Click Help->About to display the About Dialog. This displays Luna contact information, the LWA 7600 

software version information, connected hardware information, and list of optional installed 

features as shown in Figure 4-32, Figure 4-33 and Figure 4-34. 

 

Figure 4-32 About Dialog 
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Figure 4-33 About Hardware Dialog 

 

Figure 4-34 About Options Dialog 

4.6 Remote User Interface 

4.6.1 Installation 

To install the remote user interface on Ubuntu Linux, run the file LWA_UI_v<version number>.run 

(example: LWA_UI_v3.1.0.run). Upon completion, a shortcut will be placed on the desktop to launch 

the LWA Remote User Interface. 
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To install the remote user interface on MS Windows, run the file LWAInstall.msi. Upon completion, a 

shortcut will be placed on the desktop and in the MS Windows Menu to launch the LWA Remote 

User Interface. 

4.6.2 Disconnected Mode 

The user software is able to be launched in disconnected mode. This can occur in two scenarios, 

either launching the user software on a system that does not have the controller software installed 

which is further described in Section 4.6.3 Remote Connection or launching the software without 

the instrument being connected as shown in Figure 4-35. 

 

Figure 4-35 No Instrument Connected 

In disconnected mode, the user interface operates solely in file viewing mode therefore the File Open 

and File Save options are available. See Section 4.5.2 File Operations. Since there is no instrument, 

Measurement Settings is the only settings option available as described in Section 4.5.3.2 Measurement 

Settings. Also, Help does not contain the ability to update features keys and the Hardware and Options 

in the About screen are disabled. 

NOTE: When running on a MS Windows system, an MS Windows File Viewer feature license is required 

to view measurement files while disconnected.  

4.6.3 Remote Connection 

Starting with version 3.1.0, the system allows remote connections in addition to the SCPI interface. The 

LWA 7600 supports the architecture as shown in Figure 4-36. 
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Figure 4-36 Remote Connection 

The LWA 7600 Software can be installed on a Rackmount/NUC device supplied by Luna. The 

Rackmount/NUC is connected to the LWA 7600 as described in the Setup Guide. The software is started 

by connecting a mouse and keyboard to the Rackmount/NUC using the LWA 7600 User Interface. 

The LWA 7600 User Interface can be installed on either a Ubuntu or MS Windows system. To connect to 

the LWA 7600 Software running on the Rackmount/NUC, start the LWA 7600 User Interface which will 

launch the user interface in a disconnected mode as shown in Figure 4-37. The connection button  

will show as red disconnected icon when the user interface is not connected to a LWA System, referred 

to as the LWA Controller. 

 

Figure 4-37 LWA User Interface Disconnected 
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To connect to a running LWA Controller, click on the connection button  on the top right-hand 

corner of the user interface. This will display the Connection Manager Dialog as shown in Figure 

4-38. 

 

Figure 4-38 Connection Manager Dialog 

Select the controller you wish to connect to from the Available Controllers combo box. If the controller 

is not shown in the combo box, click the Enter IP Address button  to type in a known 

controller IP Address. To always connect to the LWA Controller selected, check the Auto Connect 

checkbox . The UI in Auto Connect will automatically connect to the selected LWA 

Controller on Startup. To stop using Auto Connect, uncheck the box. Click on the Connect button 

 to connect. 

Once connected, the connection icon  will turn green and show as connected. Clicking on the 

Connection Button while connected, displays the Connection Manager Dialog as shown in Figure 4-39. 

 

Figure 4-39 Connection Manager Dialog, Connected 

The Connection Manager Dialog, while connected, provides a way to rename the LWA Controller and 

provides a way to set/unset Auto Connect. To rename the controller, update the name displayed in the 

Controller Dialog . 

While connected the LWA User Interface operates as described in this document. 
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5 SCPI Interface 

5.1 Introduction to SCPI 

SCPI commands may be sent to the controller over a network interface using the TCP/IP protocol.  

The IP address of the controller is displayed in the “About” settings page for your reference. 

Port 5025 is used to communicate with the controller over a raw TCP/IP socket connection. 

When using a Telnet client, you may click alt-i to get a Telnet prompt (“>”). Note: Port 5024 is no 

longer available. 

Data returned from a SCPI Query will contain a ‘\0’ signifying the end of the data. 

5.2 Luna LWA 7600 SCPI Instrument Model 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.3 SCPI is Not a Data Streaming Protocol 

SCPI should not be used while making continuous measurements. The SCPI protocol does not allow 

for the SCPI server to send unsolicited messages to the client. This means that the LWA 7600 

software cannot send continuous measurement data as measurements are taken. 
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Instead, the client must send individual FETCh queries (ex: FETC:OFDR?, FETC:DIST?) which the 

server can respond to. However, there is no SCPI mechanism for knowing when a new measurement 

is available or to prevent the LWA 7600 from making a new measurement at the same time that the 

query is retrieving data. 

To make and retrieve measurements as quickly as possible using SCPI, the client should send the 

INIT command to initiate a measurement, followed the desired FETCh queries to retrieve data. The 

queries will not execute until the measurement has finished. This sequence can be repeated in a 

loop to acquire and retrieve multiple measurements. 

 

5.4 Example SCPI Command Sequences 

This section provides a few example command sequences to help demonstrate the use of SCPI of 

the Luna LWA 7600. 

Keep in mind that it might be a good idea to follow each SCPI command or query with :SYST:ERR? to 

determine if an error was generated during the previous program message unit.  For the sake of 

brevity, these examples don’t demonstrate the use of the :SYST:ERR? query. 

Refer to Section 5.3 for a complete list of supported SCPI commands. 

 

5.4.1 Example 1: Take Sequential Measurements 

DEL REFL # Use REFLection mode, not TRANsmission mode 

LENG 20 # Use 20 meter mode, not the 50 meter or 100 meter modes 

GIND 1.4682 # Set the group index to 1.4682 

MEAS:RL? 3,0.05 # Take a measurement and get the return loss at a distance of 3m with a width of 0.05m 

MEAS:RL? 3ft # Take a measurement and but get the return loss at 3ft (still with a width of 0.05m) 

MEAS:OFDR? # Take a measurement and return the amplitudes from the OFDR plot 

MMEM:STOR ofdr,test1 # Store the measurement data to the file “test1.ofdr” 

MMEM:STOR tsv_ose,test1 # Store all the measurement data to the file “test1.tsv” 
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5.4.2 Example 2: Get Multiple Results from a Single Measurement 

DEL REFL # Use REFLection mode, not TRANsmission mode 

LENG 20 # Use 20 meter mode, not 50 meter or 100 meter modes 

GIND 1.4682 # Set the group index to 1.4682 

CONF:RL DEF,0.05 # Set the return loss width to 0.05 meters 

CONF:IL DEF,0.2 # Set the insertion loss width to 0.2 meters 

CONF:SPEC DEF,0.5 # Set the spectral cursor width to 0.5 meters 

INIT # Start a measurement 

FETC:OFDR? # Wait for the measurement to complete and get amplitudes in dB from the OFDR plot 

FETC:DIST? # Get distances in meters from the OFDR plot 

FETC:SPEC? 1 # Get the return loss values in dB from the spectral plot with the spectral cursor at 1m 

FETC:WAV? # Get the wavelengths in nm from the spectral plot 

FETC:EVEN? # Get the event table 

FETC:RL? 1.2 # Get the return loss at a distance of 1.2 meters from the unit 

FETC:RL? 3ft # Get the return loss at a distance of 3 feet from the unit 

FETC:IL? 3.4m # Get the insertion loss at a distance of 3.4 meters from the unit 

5.4.3 Example 3: Get a Subset of the Measurement Data 

DEL REFL # Use REFLection mode, not TRANsmission mode 

LENG 20 # Use 20 meter mode, not 50 meter or 100 meter modes 

INIT # Start a measurement 

CONF:OFDR 0, 1.5, 2.5 # Configure FETC:OFDR? and DIST? queries to return data from 1.5m to 2.5m 

FETC:OFDR? # Wait for the measurement to complete and get amplitudes in dB from the OFDR plot 

FETC:DIST? # Get distances in meters from the OFDR plot 
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5.5 SCPI Command Reference 

5.5.1 SENSe Subsystem 

5.5.1.1 [:SENSe][:IFO]:DELay 
 

> [:SENSe][:IFO]:DELay <CHARACTER PROGRAM DATA> 

This command sets the measurement type.  The parameter should be either TRANsmission or 

REFLection. 

Note that IFO is an abbreviation for “interferometer”. 

If a startup configuration file is enabled, then the *RST command sets the delay to the value from 

the startup configuration file.  Otherwise, the *RST command sets the delay to REFLection. 

5.5.1.2 [:SENSe][:IFO]:DELay? 
 

> [:SENSe][:IFO]:DELay? 

< <CHARACTER RESPONSE DATA> 

This query returns the current measurement type.  The response shall be either TRAN or REFL. 

Note that IFO is an abbreviation for “interferometer”. 

5.5.1.3 [:SENSe][:IFO]:LENGth 
 

> [:SENSe][:IFO]:LENGth <numeric_value>[<SUFFIX>] 

This command sets the measurement length.  The parameter shall be 20m, 50m or 100m.  The 

default units are meters (“m”).  Although other units may be specified, the suffix (if provided) should 

be meters to guarantee that this setting is interpreted properly. 

NOTE: You must connect the Luna-supplied transmission calibration jumper prior to running this 

command. 

Note that IFO is an abbreviation for “interferometer”. 

If a startup configuration file is enabled, then the *RST command sets the measurement length to 

the value from the startup configuration file.  Otherwise, the *RST command sets the measurement 

length to 20m. 

The 50m and 100m lengths are only available on units with the corresponding feature keys installed. 

In Transmission, there is a difference between what the user interface displays and what is specified 

in the LENGth command. For example, the length of 20m will be displayed as an Acquisition Range 

of 40m. 
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5.5.1.4 [:SENSe][:IFO]:LENGth? 
 

> [:SENSe][:IFO]:LENGth? 

< <NR1> 

This query returns the current measurement length.  The response shall be 20, 50 or 100.  The 

response is always in units of meters. 

Note that IFO is an abbreviation for “interferometer”. 

In Transmission, there is a difference between what the user interface displays and what is displayed 

in the LENGth command. For example, the length of 20m will be displayed as an Acquisition Range 

of 40m. 

5.5.1.5 [:SENSe][:IFO]:GINDex 
 

> [:SENSe][:IFO]:GINDex <numeric_value> 

This command sets the group index. 

Note that IFO is an abbreviation for “interferometer”. 

If a startup configuration file is enabled, then the *RST command sets the group index to the value 

from the startup configuration file.  Otherwise, the *RST command sets the group index to 1.4682. 

5.5.1.6 [:SENSe][:IFO]:GINDex? 

> [:SENSe][:IFO]:GINDex? 

< <NR2> 

This query returns the current group index. 

Note that IFO is an abbreviation for “interferometer”. 

5.5.1.7 [:SENSe][:IFO]:FOCUs 
 

> [:SENSe][:IFO]:FOCUs <numeric_value> 

This command sets the focus value. This only applies to measurement length modes greater than or 

equal to 50m. 

Note that IFO is an abbreviation for “interferometer”. 

If a startup configuration file is enabled, then the *RST command sets the focus value to the value 

from the startup configuration file.  Otherwise, the *RST command sets the length mode to 20m and 

the turns Focus off. 

5.5.1.8 [:SENSe][:IFO]:FOCUs? 
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> [:SENSe][:IFO]:FOCUs? 

< <NR2> 

This query returns the current focus value. 

Note that IFO is an abbreviation for “interferometer”. 

 

5.5.2 CALCulate Subsystem 

5.5.2.1 :OFDR:FILTer:GAUSsian[:STATe] 
 

> :OFDR:FILTer:GAUSsian[:STATe] <boolean> 

This command turns the Gaussian filter on or off on the OFDR data plot.  A <boolean> value of 1 or 

ON turns on the Gaussian filter while a value of 0 or OFF turns it off. 

Note that OFDR is an alias for CALCulate[1].  These program mnemonics may be used 

interchangeably. 

If a startup configuration file is enabled, then the *RST command sets the Gaussian filter state to the 

value from the startup configuration file.  Otherwise, the *RST command turns the Gaussian filter 

on. 

5.5.2.2 :OFDR:FILTer:GAUSsian[:STATe]? 
 

> :OFDR:FILTer:GAUSsian[:STATe]? 

< <NR1> 

This query returns the current state of the Gaussian filter.  The response shall either be 0 to indicate 

the filter is turned off or 1 to indicate it is turned on. 

Note that OFDR is an alias for CALCulate[1].  These program mnemonics may be used 

interchangeably. 

5.5.2.3 :OFDR:FILTer:GAUSsian:WIDTh 
 

> :OFDR:FILTer:GAUSsian:WIDTh <numeric_value>{<SUFFIX>} 

This command sets the filter width for the Gaussian filter to the specified value.  The default units 

are millimeters. 

Note that OFDR is an alias for CALCulate[1].  These program mnemonics may be used 

interchangeably. 

If a startup configuration file is enabled, then the *RST command sets the Gaussian filter width to 

the value from the startup configuration file.  Otherwise, the *RST command sets the Gaussian filter 

width to 10.24mm. 

5.5.2.4 :OFDR:FILTer:GAUSsian:WIDTh? 
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> :OFDR:FILTer:GAUSsian:WIDTh? 

< <NR2> 

This query returns the current filter width of the Gaussian filter.  The response is always in units of 

millimeters. 

Note that OFDR is an alias for CALCulate[1].  These program mnemonics may be used 

interchangeably. 

5.5.3 Measurement Instructions 

5.5.3.1 :CONFigure? 
 

> :CONFigure? 

< <function> <parameters> 

This query returns the measurement function and configuration parameters for the most recently 

configured measurement function.  The parameters follow the format of the corresponding 

CONFigure query for the indicated measurement function. 

If no measurement function has been configured, then this query produces no response other than 

the response message terminator. 

5.5.3.2 :CONFigure:RL 
 

> :CONFigure:RL <numeric_value>[<SUFFIX>],<numeric_value>[<SUFFIX>] 

This command sets return loss as the current measurement and optionally sets the current return 

loss center location to the value of the first parameter and the return loss width to the value of the 

second parameter.  The default units are meters (“m”).  Other possible units include millimeters 

(“mm”), feet (“ft”), and inches (“in”).  Parameters can also be defaulted to their current value by 

omitting them from right-to-left, or by using the special parameter DEFault. 

If a startup configuration file is enabled, then the *RST command sets the return loss center location 

and width to the values from the startup configuration file.  Otherwise, the *RST command sets the 

return loss center location to 0.0m and the width to 0.05m. 

5.5.3.3 :CONFigure:RL? 
 

> :CONFigure:RL? 

< <NR2>,<NR2> 

This query returns the current return loss configuration.  The first response is the current return loss 

center location and the second response is the current return loss width.  Both values are always in 

units of meters. 

5.5.3.4 :CONFigure:IL 
 

> :CONFigure:IL <numeric_value>[<SUFFIX>],<numeric_value>[<SUFFIX>], 

<numeric_value>[<SUFFIX>] 
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This command sets insertion loss as the current measurement and optionally sets the current 

insertion loss center location to the value of the first parameter, the insertion loss width to the value 

of the second parameter and the return loss width to the value of the third parameter.  The default 

units are meters (“m”).  Other possible units include millimeters (“mm”), feet (“ft”), and inches 

(“in”).  Parameters can also be defaulted to their current value by omitting them from right-to-left, 

or by using the special parameter DEFault. 

If a startup configuration file is enabled, then the *RST command sets the insertion loss center 

location and width to the values from the startup configuration file.  Otherwise, the *RST command 

sets the insertion loss center location to 0.0m and the width to 0.2m. 

5.5.3.5 :CONFigure:IL? 
 

> :CONFigure:IL? 

< <NR2>,<NR2>,<NR2> 

This query returns the current insertion loss configuration.  The first response is the current 

insertion loss center location, the second response is the current insertion loss width and the third 

response is the current return loss width.  All values are always in units of meters. 

5.5.3.6 :CONFigure:OFDR 
 

> :CONFigure:OFDR <measurement id>,[<start>,<end>] 

This command sets the amplitude data from the OFDR graph as the current measurement. 

The optional <measurement id> parameter is an integer indicating which measurement should be 

returned from FETC:OFDR? and FETC:DIST? queries. Currently the only valid value is 0. 

The optional <start> and <end> parameters are floating point values indicating the start and end 

location for the measurement segment that will be returned. 

5.5.3.7 :CONFigure:OFDR? 
 

> :CONFigure:OFDR? 

< <NR2>,<NR2>,<NR2> 

This command returns the current setting for what has been configured to be return when using 

Fetch:OFDR?, FETC:DIST? Queries. 

5.5.3.8 :CONFigure:DISTance 
 

> :CONFigure:DISTance [<measurement id>],[<start>,<end>] 

This command sets the distance data from the OFDR graph as the current measurement. 

The optional <measurement id> parameter is an integer indicating which measurement should be 

returned from FETC:OFDR? and FETC:DIST? queries. Currently the only valid value is 0. 
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The optional <start> and <end> parameters are floating point values indicating the start and end 

location for the measurement segment that will be returned. 

5.5.3.9 :CONFigure:SPECtral 
 

> :CONFigure:SPECtral <numeric_value>[<SUFFIX>],<numeric_value>[<SUFFIX>] 

This command sets the current spectral center location to the value of the first parameter and the 

current spectral width to the value of the second parameter.  The default units are meters (“m”).  

Other possible units include millimeters (“mm”), feet (“ft”), and inches (“in”).  Parameters can also 

be defaulted to their current value by omitting them from right-to-left, or by using the special 

parameter DEFault. 

If a startup configuration file is enabled, then the *RST command sets the spectral center location 

and width to the values from the startup configuration file.  Otherwise, the *RST command sets the 

spectral center location to 0.0m and the width to 0.5m. 

This command is only available on units with the spectral feature key installed. 

5.5.3.10 :CONFigure:SPECtral? 
 

> :CONFigure:SPECtral? 

< <NR2> 

This query returns the current spectral configuration.  The first response is the current spectral 

center location and the second response is the current spectral width.  Both values are always in 

units of meters. 

This query is only available on units with the spectral feature key installed. 

5.5.3.11 :CONFigure:EVENt 
 

> :CONFigure:EVENt <numeric_value>[<SUFFIX>],<numeric_value>[<SUFFIX>], 

<numeric_value>[dB],<numeric_value>[dB] 

This command sets event detection as the current measurement and optionally sets the minimum 

event location to the first parameter, the maximum event location to the second parameter, the RL 

threshold to the third parameter and the IL threshold to the fourth parameter.  The default units for 

the minimum and maximum event locations are meters (“m”).  Other possible units include 

millimeters (“mm”), feet (“ft”), and inches (“in”).  The default units for the RL and IL thresholds are 

decibels (“dB”).  Parameters can also be defaulted to their current value by omitting them from 

right-to-left, or by using the special parameter DEFault. 

If a startup configuration file is enabled, then the *RST command sets the minimum event location, 

maximum event location, RL threshold and IL threshold to the values from the startup configuration 

file.  Otherwise, the *RST command sets the minimum event location to -1.0m, the maximum event 

location to 20.0m, the RL threshold to -4.0dB and the IL threshold to 2.0dB. 
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5.5.3.12 :CONFigure:EVENt? 
 

> :CONFigure:EVENt? 

< <NR2>,<NR2>,<NR2>,<NR2> 

This query returns the current event configuration.  The first response is the minimum event 

location, the second response is the maximum event location, the third response is the RL threshold 

and the fourth response is the IL threshold.  The minimum and maximum event locations are always 

in units of meters and the RL and IL thresholds are always in units of decibels. 

5.5.3.13 :BINary 

> :BINary <boolean> 

This command turns the binary output mode on or off.  A <boolean> value of 1 or ON turns on the 

binary output while a value of 0 or OFF turns it off. 

This command affects the following FETCh commands: 

• :FETCh:OFDR? 

• :FETCh:DISTance? 

• :FETCh:SPECtral? 

• :FETCh:WAVelength? 

The default for the BINary command is off where the above commands will output data in ASCII 

format. 

When binary is turned on, the above commands will output data in a length-prefixed array of IEEE-

754 32-bit floating-point values. The first 4 bytes is an unsigned 32-bit integer count in little-endian 

byte order representing the number of data points. This is followed by the count of consecutive 4 

bytes of IEEE-754 single-precision (32-bit) values in little-endian byte order. There are no delimiters 

such as commas or terminators inside the binary output. 

5.5.3.14 :BINary? 

> :BINary? 

< <NR1> 

This query returns the current state of the binary output.  The response shall either be OFF to 

indicate the filter is turned off or ON to indicate it is turned on. 

5.5.3.15 :FETCh? 
 

> :FETCh? <parameters> 

< (see the corresponding :FETCh:<function>? query for the response format) 

The last measurement function FETChed, READ or MEASured will be fetched. 

If no measurement function has been used, then this query produces no response other than the 

response message terminator. 
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5.5.3.16 :FETCh:RL? 
 

> :FETCh:RL? <numeric_value>[<SUFFIX>],<numeric_value>[<SUFFIX>] 

< <NR2> 

This query waits for a measurement to complete and returns the measured return loss in dB.  The 

command also optionally sets the return loss center location to the value of the first parameter and 

the return loss width to the value of the second parameter.  The default units are meters (“m”).  

Other possible units include millimeters (“m”), feet (“ft”), and inches (“in”).  Parameters can also be 

defaulted to their current value by omitting them from right-to-left, or by using the special 

parameter DEFault. 

5.5.3.17 :FETCh:IL? 
 

> :FETCh:IL? <numeric_value>[<SUFFIX>],<numeric_value>[<SUFFIX>] 

< <NR2> 

This query waits for a measurement to complete and returns the measured insertion loss in dB.  The 

command also optionally sets the insertion loss center location to the value of the first parameter 

and the insertion loss width to the value of the second parameter.  The default units are meters 

(“m”).  Other possible units include millimeters (“m”), feet (“ft”), and inches (“in”).  Parameters can 

also be defaulted to their current value by omitting them from right-to-left, or by using the special 

parameter DEFault. 

5.5.3.18 :FETCh:OFDR? 
 

> :FETCh:OFDR? [<measurement id>],[<start>,<end>] 
< <NR2>{,<NR2>} 

This query waits for a measurement to complete and returns the amplitude data from the OFDR 

graph.  Each data point is always in units of decibels.  Note that the corresponding distance 

coordinate values for this data can be returned by using the :FETCh:DISTance? query. 

The optional <measurement id> parameter is an integer indicating which measurement should be 

saved. Currently the only valid value is 0. 

The optional <start> and <end> parameters are floating point values indicating the start and end 

location for the measurement segment that will be returned. 

5.5.3.19 :FETCh:DISTance? 
 

> :FETCh:DISTance? [<measurement id>],[<start>,<end>] 
< <NR2>{,<NR2>} 

This query waits for a measurement to complete and returns the distance data from the OFDR 

graph.  Each data point is always in units of meters.  Note that the corresponding amplitude 

coordinate values for this data can be returned by using the :FETCh:OFDR? query. 

The optional <measurement id> parameter is an integer indicating which measurement should be 

saved. Currently the only valid value is 0. 
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The optional <start> and <end> parameters are floating point values indicating the start and end 

location for the measurement segment that will be returned. 

5.5.3.20 :FETCh:SPECtral? 
 

> :FETCh:SPECtral <numeric_value>[<SUFFIX>],<numeric_value>[<SUFFIX>] 

< <NR2>{,<NR2>} 

This query waits for a measurement to complete and returns the return loss data from the spectral 

graph.  Each data point is always in units of decibels.  Note that the corresponding wavelength 

coordinate values for this data can be returned by using the :FETCh:WAVelength? query.  The 

command also optionally sets the current spectral center location to the value of the first 

parameter, and the current spectral width to the value of the second parameter.  The default units 

are meters (“m”).  Other possible units include millimeters (“m”), feet (“ft”), and inches (“in”).  

Parameters can also be defaulted to their current value by omitting them from right-to-left, or by 

using the special parameter DEFault. 

This query is only available on units with the spectral feature key installed. 

5.5.3.21 :FETCh:GD? 
 

> :FETCh:GD <numeric_value>[<SUFFIX>],<numeric_value>[<SUFFIX>] 

< <NR2>{,<NR2>} 

This query waits for a measurement to complete and returns the group delay data from the spectral 

graph.  Each data point is always in units of nanoseconds.  Note that the corresponding wavelength 

coordinate values for this data can be returned by using the :FETCh:WAVelength? query.  The 

command also optionally sets the current spectral center location to the value of the first 

parameter, and the current spectral width to the value of the second parameter.  The default units 

are meters ("m").  Other possible units include millimeters ("mm"), feet ("ft"), and inches ("in").  

Parameters can also be defaulted to their current value by omitting them from right-to-left, or by 

using the special parameter DEFault. 

This query is only available on units with the spectral feature key installed. 

5.5.3.22 :FETCh:WAVelength? 
 

> :FETCh:WAVelength? 

< <NR2>{,<NR2>} 

This query waits for a measurement to complete and returns the wavelength data from the OFDR 

graph.  Each data point is always in units of nanometers.  Note that the corresponding return loss 

coordinate values for this data can be returned by using the :FETCh:SPECtral? query. 

This query is only available on units with the spectral feature key installed. 

5.5.3.23 :FETCh:EVENt? 
 

> :FETCh:EVENt? 

< <EXPR>{,<EXPR>} 
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This query returns a list of events for the current measurement.  Each <EXPR> result is formatted as: 

 (<NR2>,<NR1>,<NR2>,<NR2>) 

The values in each <EXPR> represent, in order, the following values: 

• location of the event in meters 

• for reflection, event type as an integer (0 for a return loss event, 1 for an insertion loss event) 

• for transmission, event type as an integer (0 for an insertion loss event) 

• return loss at the event location in dB 

• insertion loss at the event location in dB 

 

 

5.5.3.24 :READ[:<function>]? 
 

> :READ[:<function>]? <parameters> 

< (see the corresponding :FETCh:<function>? query for the response format) 

This query is identical to: 

ABORt; 

INITiate; 

FETCh[:<function>]? <parameters> 

If the <function> is not specified in the query, then the last measurement function FETChed, READ or 

MEASured will be read. 

If no measurement function has been used, then this query produces no response other than the 

response message terminator. 

5.5.3.25 :MEASure[:<function>]? 
 

> :MEASure[:<function>]? <parameters> 

< (see the corresponding :FETCh:<function>? query for the response format) 

This query is identical to: 

ABORt; 

CONFigure:<function> <parameters>; 

READ:<function>? <parameters>[,<source list>]; 

If the <function> is not specified in the query, then the last measurement function FETChed, READ or 

MEASured will be measured. 

If no measurement function has been used, then this query produces no response other than the 

response message terminator. 
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5.5.4 TRIGger Subsystem 

5.5.4.1 :INITiate[:ALL]  
 

> :INITiate[:ALL] 

This command acquires a single measurement.  Error -213 “Init ignored” is generated if the 

instrument is not ready or if a measurement is already in progress. 

5.5.5 MMEMory Subsystem 

5.5.5.1 :MMEMory:LOAD:STATe 
 

> :MMEMory:LOAD:STATe <numeric_value>,<file_name> 

This command loads instrument configuration data from a file.  The <numeric_value> is the memory 

register number where the configuration data will be loaded into the instrument.  Memory register 

0 represents the current configuration in use by the instrument.  Memory register 1 represents the 

default settings that will be used whenever the application on the PC is launched.  The <file_name> 

is a quoted string representing the filename of the configuration file to load.  If the filename does 

not end with the extension “.config”, then “.config” will be appended to the filename. 

 

 

 

 

5.5.5.2 :MMEMory:STORe:STATe 
 

> :MMEMory:STORe:STATe <numeric_value>,<file_name> 

This command saves instrument configuration data to a file.  The <numeric_value> is the memory 

register number containing the instrument configuration to be saved to the file.  Memory register 0 

represents the current configuration in use by the instrument.  Memory register 1 represents the 

default settings that will be used whenever the application on the PC is launched.  The <file_name> 

is a quoted string representing the filename of the configuration file to save.  If the filename does 

not end with the extension “.config”, then “.config” will be appended to the filename. 

If an attempt to store memory register 1 is made and no startup configuration file is currently 

selected, then this command will return error -314. 

5.5.5.3 :MMEMory:STORe[:CUSTom] 
 

> :MMEMory:STORe[:CUSTom] <label>,<file_name>,[<measurement 

id>],[<start>,<end>] 

This command stores the current measurement data to a file.  The <label> identifies what type of 

file will be stored: 
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OFDR OFDR measurement file 

TSV Tab-separated value file containing only the header 

TSV_E Tab-separated value file containing the events detected 

TSV_S Tab-separated value file containing the spectral data 

TSV_SE Tab-separated value file containing the spectral data and the events detected 

TSV_O Tab-separated value file containing the OFDR data 

TSV_OE Tab-separated value file containing the OFDR data and the events detected 

TSV_OS Tab-separated value file containing the OFDR data and the spectral data 

TSV_OSE Tab-separated value file containing all the data 

The <file_name> is a quoted string representing the name of the file to save.  If the <label> is OFDR 

and the filename does not end with the extension “.ofdr”, then “.ofdr” will be appended to the 

filename.  If <label> starts with TSV and the filename does not end with the extension “.tsv”, then 

“.tsv” will be appended to the filename. 

The optional <measurement id> parameter is an integer indicating which measurement should be 

saved. Currently the only valid value is 0. 

The optional <start> and <end> parameters are floating point values indicating the start and end 

location for the measurement segment that should be saved. This only affects the OFDR data 

written to the TSV file. 

 

5.5.6 SYSTem Subsystem 

5.5.6.1 :SYSTem:ERRor[:NEXT]? 
 

> :SYSTem:ERRor[:NEXT]? 

< <NR1>,<STRING RESPONSE DATA> 

This query removes the next item from the Error/Event Queue and returns it in the response. 

The <NR1> number is an Error/Event number in the range of -327678 through 32767.  The <STRING> 

is a description of the Error/Event. 

If there are no entries in the Error/Event Queue, then the response is: 

 0,”No error” 

The Error/Event Queue shall be cleared by the *CLS command or by reading the last item from the 

queue. 

 

5.5.6.2 :SYSTem:VERSion? 
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> :SYSTem:VERSion? 

< <NR2> 

This query returns the SCPI version number for which the instrument complies in the response. 

The response is always 1999.0. 

5.5.7 STATus Subsystem 

5.5.7.1 :STATus:OPERation:CONDition? 
 

> :STATus:OPERation:CONDition? 

< <NR1> 

This query returns the value of the OPERation:CONDition register.  The response shall be in the 

range of 0 through 32767. 

The SCPI standard defines the following bits for the OPERation:CONDition register. 

Bit Meaning 

 1 if the instrument is… 

 

0: CALibrating …currently performing a calibration 

1: SETTling …waiting for signals it controls to stabilize enough to begin measurements 

2: RANGing …currently changing its range 

3: SWEeping …performing a sweep operation that’s still in progress 

4: MEASuring …actively measuring 

5: Waiting for TRIG …in a “wait for trigger” state of the trigger model 

6: Waiting for ARM …in a “wait for arm” state of the trigger model 

7: CORRecting …currently performing a correction 

8: <unused> Available for instrument-defined use 

9: <unused> Available for instrument-defined use 

10: <unused> Available for instrument-defined use 

11: <unused> Available for instrument-defined use 

12: <unused> Available for instrument-defined use 

13: INSTrument Summary 1 if one of n multiple logical instruments is reporting OPERational status 

14: PROGram running 1 if a user-defined programming is currently in the run state 

15: <always 0> Always 0 because some controllers can’t handle responses larger than 32767 

Only the following bits are currently used by the instrument. 

Bit Meaning 

1: SETTling 1 if the instrument is waiting for the laser to stabilize 

2: RANGing 1 if the instrument is changing laser modes 

4: MEASuring 1 if the instrument is taking a measurement 

7: CORRecting 1 if the instrument is automatically aligning or adjusting gains 

8: INITializing 1 if the instrument is initializing 

All Other Bits Always 0 
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The OPERation:CONDition register is not affected by the *CLS or *RST commands. 

The OPERation:CONDition register is cleared when the application on the PC is started. 

5.5.7.2 :STATus:OPERation[:EVENt]? 
 

> :STATus:OPERation[:EVENt]? 

< <NR1> 

This query returns the value of the OPERation:EVENt register.  The response shall be in the range of 

0 through 32767. 

Bits in this register are latched to a 1 if the corresponding bit in the OPERation:CONDition register 

becomes  a 1.  Refer to the description of the :STATus:OPERation:CONDition? query for details on 

how each bit is defined. 

The OPERation:EVENt register is not affected by the *RST command. 

The OPERation:EVENt register is cleared by the STATus:OPERation[:EVENt]? query, the *CLS 

command or when the application on the PC is started. 

5.5.7.3 :STATus:OPERation:ENABle 
 

> :Status:OPERation:ENABle <NRf> | <non-decimal numeric> 

This command sets the bits of the OPERation:ENABle register.  The <NRf> value (when rounded to 

an integer value) or the <non-decimal numeric> should be in the range of 0 through 32767. 

Bit Meaning 

 Set the OPERation Summary bit in the Status Byte if… 

 

1: SETTling Enable …the SETTling bit is set in OPERation:CONDition 

2: RANGing Enable …the RANGing bit is set in OPERation:CONDition 

4: MEASuring Enable …the MEASuring bit is set in OPERation:CONDition 

7: CORRecting Enable …the CORRecting bit is set in OPERation:CONDition 

8: INITializing Enable …the INITializing bit is set in OPERation:CONDition 

15: <always 0> Always 0 because some controllers can’t handle responses larger than 32767 

 

All Other Bits Can be set to 0 or 1, but the value is ignored because the corresponding bit in 

     OPERation:CONDition is 0 

The OPERation:ENABle register is not affected by the *CLS or *RST commands. 

The OPERation:ENABle register is cleared when the application on the PC is started. 

5.5.7.4 :STATus:OPERation:ENABle? 
 

> :STATUS:OPERation:ENABle? 

< <NR1> 
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This query returns the value of the OPERation:ENABle register.  The result shall be in the range of 0 

through 32767.  Refer to the description of the :STATus:OPERation:ENABLe command for details on 

how each bit is defined. 

5.5.7.5 :STATus:QUEStionable:CONDition? 
 

> :STATus:QUEStionable:CONDition? 

< <NR1> 

This query returns the value of the QUEStionable:CONDition register.  The response shall be in the 

range of 0 through 32767. 

The SCPI standard defines the following bits for the QUEStionable:CONDition register. 

Bit Meaning 

 1 if the accuracy of the… 

 

0: VOLTage …voltage acquired/generated was of questionable quality 

1: CURRent …current acquired/generated was of questionable quality 

2: TIME …time acquired/generated was of questionable quality 

3: POWer …power acquired/generated was of questionable quality 

4: TEMPerature …temperature acquired/generated was of questionable quality 

5: FREQuency …frequency acquired/generated was of questionable quality 

6: PHASe …phase acquired/generated was of questionable quality 

7: MODulation …modulation acquired/generated was of questionable quality 

8: CALibration …calibration acquired/generated was of questionable quality 

9: <unused> Available for instrument-defined use 

10: <unused> Available for instrument-defined use 

11: <unused> Available for instrument-defined use 

12: <unused> Available for instrument-defined use 

13: INSTrument Summary 1 if one of n multiple logical instruments is reporting QUEStionable status 

14: Command Warning 1 if the command/query completed successfully but may deviate in some manner 

15: <always 0> Always 0 because some controllers can’t handle responses larger than 32767 

Only the following bits are currently used by the instrument. 

Bit Meaning 

All Bits Always 0 

The QUEStionable:CONDition register is not affected by the *CLS or *RST commands. 

The QUEStionable:CONDition register is cleared when the application on the PC is started. 

5.5.7.6 :STATus:QUEStionable[:EVENt]? 
 

> :STATus:QUEStionable[:EVENt]? 

< <NR1> 
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This query returns the value of the QUEStionable:EVENt register.  The response shall be in the range 

of 0 through 32767. 

Bits in this register are latched to a 1 if the corresponding bit in the QUEStionable:CONDition 

register becomes  a 1.  Refer to the description of the :Status:QUEStionable:CONDition? query for 

details on how each bit is defined. 

The QUEStionable:EVENt register is not affected by the *RST command. 

The QUEStionable:EVENt register is cleared by the STATus:QUEStionable[:EVENt]? query, the *CLS 

command or when the application on the PC is started. 

5.5.7.7 :STATus:QUEStionable:ENABle 
 

> :STATus:QUEStionable:ENABle <NRf> | <non-decimal numeric> 

This command sets the bits of the QUEStionable:ENABle register.  The <NRf> value (when rounded 

to an integer value) or the <non-decimal numeric> should be in the range of 0 through 32767. 

Bit Meaning 

15: <always 0> Always 0 because some controllers cannot handle responses larger than 32767 

All Other Bits Can be set to 0 or 1, but the value is ignored because the corresponding bit in 

     QUEStionable:CONDition is 0 

The QUEStionable:ENABle register is not affected by the *CLS or *RST commands. 

The QUEStionable:ENABle register is cleared when the application on the PC is started. 

 

5.5.7.8 :STATus:QUEStionable:ENABle? 
 

> :STATus:QUEStionable:ENABle? 

< <NR1> 

This query returns the value of the QUEStionable:ENABle register.  The result shall be in the range of 

0 through 32767.  Refer to the description of the :STATus:QUEStionable:ENABLe command for 

details on how each bit is defined. 

5.5.7.9 :STATus:PRESet 
 

> :STATus:PRESet 

This command configures SCPI such that only device-dependent events are reported through the 

standard status-reporting mechanism. 

This command performs the following actions: 

(1) For SCPI mandatory status data structures, set the ENABle register to all 0’s and set the 
transition filter registers to only recognize positive transitions (PTR to all 1’s and NTR to all 0’s).  
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This includes OPERation:ENABle/PTR/NTR, QUEStionable:ENABle/PTR/NTR and 
ISUMmary:ENABle/PTR/NTR (required only for instruments with multiple devices). 

(2) For all other device-dependent status data structures, set the enable register to all 1’s and the 
transition registers to a device-dependent state.  This includes INSTrument:ENABle/PTR/NTR 
and any other ENABle/PTR/NTR registers defined by the instrument. 

(3) Sets the Error/Event Queue enable to only report errors. 
 

This command does NOT perform any of the following actions: 

(1) Change the state of any IEEE 488.2 register, including STB, SRE, ESR or ESE. 
(2) Change the state of any EVENt register. 
(3) Clear any item from the Error/Event Queue. 

 
To extend the concept of only reporting device-dependent events, the following sequence of 

commands would be needed to alter both the IEEE 488.2 and SCPI status reporting structures: 

*CLS 

*SRE 0 

*ERE 0 

STATus:PRESet 

Not all the registers described above are available on this instrument.  To be more specific, this 

instrument only performs the following actions when receiving the STATus:PRESet command: 

(1) OPERation:ENABle and QUEStionable:ENABle are set to 0. 
(2) The Error/Event Queue is not affected because it only reports errors by default. 

 

 

5.5.8 Common Commands and Queries 

5.5.8.1 *STB? – Read Status Byte Query 
 

> *STB? 

< <NR1> 

This query returns the value of the Status Byte Register.  The response shall be in the range of 0 

through 255. 

Bit Meaning See Also 

0: <reserved> always reads as 0 

1: <reserved> always reads as 0 

2: Error/Event Queue Summary 1 if not empty SYSTem:ERRor? 

3: QUEStionable Summary 1 if any enabled bit is set in QUEStionable:EVEnt STATus:QUEStionable:* 

4: Message Available (MAV) 1 if any characters are available in the Output Queue 

5: Event Status Bit (ESB) 1 if any enabled bit is set in the ESR *ESR, *ESR?, *ESE, *ESE? 
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6: Master Status Summary (MSS) 1 if any enabled bit is set in the Status Byte *STB?, *SRE, *SRE? 

7: OPERation Summary 1 if any enabled bit is set in OPERation:EVEnt STATus:OPERation:* 

There is currently no separate control channel for emulating GPIB handshaking using the MSS/RQS 

bit. 

IEEE 488.2 section 11.2.1.2 recommends documenting any device-specific behavior of the MAV bit.  

The MAV bit is simply an instantaneous indication of whether or not the Output Queue is empty.  

There is no attempt to “improve performance” by delaying the clearing of MAV until after the 

Response Message Terminator (RMT) is sent.  However, the MAV bit is of limited usefulness over an 

Ethernet connection. 

Additional information on how some of these bits change state is summarized in the table below: 

Bit How the current state is computed How it can be cleared 

ESB (ESR & ESE) != 0 *CLS 

  *ESR? 

  *ESE 0 

 

MSS (STB & SRE) != 0 *CLS 

  *SRE 0 

  service all enabled status bits 

 

QUEStionable Summary (QUEStionable:EVENt & QUEStionable:ENABle) != 0 *CLS 

  :QUEStionable:EVENt? 

  :QUEStionable:ENABle 0 

 

OPERation Summary (OPERation:EVENt & OPERation:ENABle) != 0 *CLS  

  :OPERation:EVENt? 

  :OPERation:ENABle 0 

 

Note that the ESR, QUEStionable:EVENt and OPERation:EVENt registers are latching, so the summary 

bit is not automatically cleared when the condition that originally caused it goes away. 

The STB register is not explicitly cleared by the *CLS command.  However, the *CLS command will 

clear other registers and queues which will indirectly clear all bits in the STB register except for the 

MAV bit.  If the *CLS command immediately follows a program message terminator (a linefeed 

character), then the MAV bit will also be cleared because any new command after a program 

message terminator clears the Output Queue. 

The STB register is not affected by the *RST command. 

The STB register is cleared when the application on the PC is started. 

5.5.8.2 *SRE -- Service Request Enable Command 
 

> *SRE <NRf> 
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This command sets the bits of the Service Request Enable Register.  The <NRf> value (when rounded 

to an integer value) should be in the range of 0 through 255. 

Bit Meaning 

 Set the MSS bit in the Status Byte if the… 

 

0: <reserved> Can be set to 0 or 1, but the value is ignored because bit 0 in the STB is always 0 

1: <reserved> Can be set to 0 or 1, but the value is ignored because bit 1 in the STB is always 0 

2: Error/Event Queue Enable …Error/Event Queue Status bit is set in the Status Byte 

3: QUEStionable Enable …QUEStionable Summary bit is set in the Status Byte 

4: MAV Enable …MAV bit is set in the Status Byte 

5: ESB Enable …ESB bit is set in the Status Byte 

6: <unused> Always reads as 0; cannot be set to 1 

7: OPERation Enable …OPERation:Summary bit is set in the Status Byte 

The SRE register is not affected by the *CLS or *RST commands. 

The SRE register is cleared when the application on the PC is started. 

5.5.8.3 *SRE? -- Service Request Enable Query 
 

> *SRE? 

< <NR1> 

This query returns the value of the Service Request Enable Register.  The result shall be in the range 

of 0 through 63 or 128 through 191.  Refer to the description of the *SRE command for details on 

how each bit is defined. 

 

5.5.8.4 *ESR? -- Standard Event Status Register Query 
 

> *ESR? 

< <NR1> 

This query returns the value of the Standard Event Status Register.  The result shall be in the range 

of 0 through 255. 

Bit Meaning 

0: Power On (PON) The PC application was (re-)started. 

1: User Request (URQ) A User Request control has been activated -- Always 0 

2: Command Error (CME) A Command Error was detected by the parser 

3: Execution Error (E) An Execution Error was detected by the parser 

4: Device Dependent Error (DDE) A Device Dependent Error was detected by the parser 

5: Query Error (QYE) A Query Error was detected by the parser 

6: Request Control (RQC) Device requests permission to become the active IEEE488.1 controller-in- 

     charge -- Always 0 

7: Operation Complete (OPC) The device has completed all selected pending operations, in response to 
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     the *OPC command 

8-15: <reserved> These bits are explicitly reserved for future use by IEEE 488.2 -- Always 0 

The ESR register is not affected by the *RST command. 

The ESR register is cleared by the *ESR? query, the *CLS command or when the application on the 

PC is started. 

5.5.8.5 *ESE -- Standard Event Status Enable Command 
 

> *ESE <NRf> 

This command sets the bits of the Standard Event Status Enable Register.  The <NRf> value (when 

rounded to an integer value) should be in the range of 0 through 255. 

Bit Meaning 

 Set the ESB in the Status Byte if the… 

 

0: Power On (PON) Enable …Power On bit is set in the ESR 

1: User Request (URQ) Enable …User Request bit is set in the ESR 

2: Command Error (CME) Enable …Command Error bit is set in the ESR 

3: Execution Error (E) Enable …Execution Error bit is set in the ESR 

4: Device Dependent Error (DDE) Enable …Device Dependent Error bit is set in the ESR 

5: Query Error (QYE) Enable …Query Error bit is set in the ESR 

6: Request Control (RQC) Enable …Request Control bit is set in the ESR 

7: Operation Complete (OPC) Enable …Operation Complete bit is set in the ESR 

8-15: <reserved> These bits are explicitly reserved for future use by IEEE 488.2 –  

     Always 0 

The ESE register is not affected by the *CLS or *RST commands. 

The ESE register is cleared when the application on the PC is started. 

5.5.8.6 *ESE? -- Standard Event Status Enable Query 
 

> *ESE? 

< <NR1> 

This query returns the value of the Standard Event Status Register.  The result shall be in the range 

of 0 through 255.  Refer to the description of the *ESE command for details on how each bit is 

defined. 

5.5.8.7 *WAI -- Wait-to-Continue Command 
 

> *WAI 

This command shall prevent the device from executing any further commands until all pending 

selected device operations (overlapped commands) have completed. 
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If the device only implements sequential commands, then the *WAI command does nothing and 

continues executing any subsequent commands immediately. 

5.5.8.8 *OPC -- Operation Complete Command 
 

> *OPC 

This command causes the device to set the Operation Complete bit (bit 7) in the ESR register when 

all pending selected device operations (overlapped commands) have completed.  Unlike the *WAI 

command, the device will continue to execute commands after the *OPC command. 

If the device only implements sequential commands, then the *OPC command simply sets the OPC 

bit (bit 7) in the ESR register immediately. 

5.5.8.9 *OPC? -- Operation Complete Query 
 

> *OPC? 

< <NR1> 

This query shall wait until all pending selected device operations (overlapped commands) have 

completed and then responds with a result of “1”.  More specifically, it will place a single ASCII 

character “1” in the Output Queue.  The *OPC? query is a sequential command.  Therefore, like the 

*WAI command, the *OPC? query shall prevent the device from executing any further commands 

until all pending selected device operations (overlapped commands) have completed. 

If the device only implements sequential commands, then the *OPC? query responds immediately 

with a “1”. 

 

5.5.8.10 *CLS -- Clear Status Command 
 

> *CLS 

This command performs the following actions: 

(1) Sets all event status registers to zero.  On this instrument, this includes ESR, OPERation:EVENt 
and QUEStionable:EVENt. 

(2) Aborts any active *OPC command.  Another *OPC command will need to be executed to set the 
OPC bit in the ESR register. 

(3) Clears the Error/Event Queue, which will also clear the Error/Event Queue Summary bit in the 
STB register. 
 

The Clear Status Command does NOT perform any of the following actions: 

(1) Change the state of the STB register (except indirectly). 
(2) Change the state of the SRE register. 
(3) Change the state of any event enable registers.  On this instrument, this includes ESE, 

OPERation:ENABle and QUEStionable:ENABle. 
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5.5.8.11 *RST -- Reset Command 
 

> *RST 

This command performs the following actions: 

(1) Aborts any active *OPC command.  Another *OPC command will need to be executed to set the 
OPC bit in the ESR register. 

(2) Sets all device settings to their default state.  All device settings in this document will define 
their *RST state. 
 

The Reset Command does NOT perform any of the following actions: 

(1) Change the state of the STB register. 
(2) Change the state of the SRE register. 
(3) Change the state of any event enable registers.  On this instrument, this includes ESE, 

OPERation:ENABle and QUEStionable:ENABle. 
(4) Change the state of any event status registers.  On this instrument, this includes ESR, 

OPERation:EVENt and QUEStionable:EVENt. 
(5) Change the state of the Error/Event Queue. 

5.5.8.12 *IDN? -- Identification Query 
 

> *IDN? 

< <ARBITRARY ASCII RESPONSE DATA> 

This query requests the device to provide a unique identification for itself.  The response is 

organized into four fields separated by commas as follows: 

 <manufacturer>,<model>,<serial_number>,<firmware_level> 

For the LWA 7600-C, the response looks like this: 

Luna, 7600-C,<serial_number>,<firmware_level> 

For the Luna LWA 7600, the <firmware_level> looks like this: 

controller:<controller_software_version>[<controller_build_date>-

<controller_build_time>] 

+embedded: <embedded_software_version>[<embedded_build_date>-

<embedded_build_time>] 

+fpga: <fpga_version>[<fpga_build_date>-<fpga_build_time>] 

Note that there are no newlines in the response, except at the end of the message.  The line breaks 

above were only added to make the output more readable in this document. 

5.5.8.13 *TST? -- Self-Test Query 
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> *TST? 

< <NR1> 

This query causes an internal self-test to be performed on the device.  The response shall be in the 

range of -32767 to 32767.  A result of 0 indicates that the self-test passed and any other result 

indicates that the self-test failed. 

All device settings will be returned to their values prior to execution of the *TST command. 

Currently, this device does not perform any self-tests.  Therefore, this command does nothing 

except return a result of “0”. 

5.5.8.14 *RCL – Recall Command 
 

> *RCL <NRf> 

This command loads the current instrument configuration data from memory register number 

specified by the parameter.  Memory register 0 represents the current configuration in use by the 

instrument.  Memory register 1 represents the default settings that will be used whenever the 

application on the PC is launched.  Therefore, *RCL 1 will load the default instrument configuration.  

Note that *RCL 0 effectively does nothing. 

If no startup configuration file is currently selected, then *RCL 1 will return error -314 “Save/recall 

memory lost”. 

5.5.8.15 *SAV – Save Command 
 

> *SAV <NRf> 

This command saves the current instrument configuration data to memory register number 

specified by the parameter.  Memory register 0 represents the current configuration in use by the 

instrument.  Memory register 1 represents the default settings that will be used whenever the 

application on the PC is launched.  Therefore, *SAV 1 will overwrite the default instrument 

configuration with the current settings.  Note that *SAV 0 effectively does nothing. 

If no startup configuration file is currently selected, then *SAV 1 will return error -314 “Save/recall 

memory lost”. 
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Appendix A Theory of Operation 

The LUNA LWA 7600 utilizes swept-wavelength interferometry to measure the device or system 

under test. Swept wavelength interferometry provides for a zero dead-zone, extremely high-

resolution measurement of the light reflected (or transmitted) through the device under test (DUT). 

Interference 

When multiple sources of light of differing frequency (wavelength) interact, they generate an 

interference pattern. The resulting interference pattern has an amplitude envelope with a frequency 

that is proportional to the difference in the frequencies of the two source waves. 

 

Figure 5-1 Interference patter from two waves of differing frequency 

Swept Wavelength Interferometry 

A fiber optic interferometer utilizes two paths, a reference, and a measurement, to split and 

recombine light. Light is sent into the optical network from a laser before it is split into two paths 

using an optical coupler. The paths are recombined using another optical coupler where the light 

interferes, and the resulting interference pattern is converted to an electrical signal using a 

photodetector. 
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Figure 5-2 Fiber Optic Interferometer Network 

The tunable laser is configured to perform a linear sweep through a range of optical frequencies. 

Due to this linear sweep, any length differences between the reference and measurement paths of 

the interferometer will cause an interference pattern to appear at the detector. The interference 

frequency is proportional to the path length difference (time of flight) and the optical frequency 

tuning rate of the laser. The optical network shown above would generate an interference pattern 

with a single frequency. 

 

Figure 5-3 OFDR interference frequency is proportional to the time of flight difference and the tuning rate of the laser 

 

Optical Frequency Domain Reflectometry (OFDR) 

The OBR uses the principles of swept wavelength interferometry to make measurements of optical 

networks in reflection. This means that the OBR is configured to characterize the light that is 

reflected back through a network from things such as connectors, lenses, fiber breaks, etc. To do 

this, a circulator is added to the measurement path of the interferometer. Reflections from user 

connected DUTs pass back into the interferometer and interfere with light from the reference path. 

 

 

Figure 5-4 Basic OBR Optical Network with two partial reflectors (connectors) 
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In the example above, two partial reflectors (connectors) reflect a small portion of the measurement 

path light back into the network and to the detector.  Since there is a path length difference 

associated with each reflector, they will both generate interference fringes at different frequencies. 

The detector will receive the superposition of these two interference fringes (shown below). 

 

 

 
 

Figure 5-5 Resulting interference pattern from two reflectors at different locations 

By taking a Fourier transform of this interference pattern, we can look at a plot which shows the 

reflected light vs optical time of flight (fiber length). The amplitude of each of these peaks is 

proportional to the amount of light reflected at any point in the fiber network. Once calibrated, the 

amplitude data is scaled to show the reflectance (return loss) as a function of fiber length.  

Important OFDR Terms 

Delay Domain – This is the domain which shows the reflections vs optical time of flight (delay). This 

delay can be scaled into length if the group index of refraction for the optical path is known. 

 

Return Loss (RL) – Often used interchangeably with reflectance in the optics industry, the return loss 

is the logarithmic scaling of the reflected power to the incident power. 

𝑅𝐿 = 10𝑙𝑜𝑔 (
𝑃𝑟𝑒𝑓𝑙𝑒𝑐𝑡𝑒𝑑

𝑃𝑖𝑛𝑐𝑖𝑑𝑒𝑛𝑡
) 

 

Insertion Loss (IL) – The insertion loss describes how much light does not pass through a portion of 

the optical network. The IL is the logarithmic scaling of the transmitted to the incident power. 

𝐼𝐿 = 10𝑙𝑜𝑔 (
𝑃𝑡𝑟𝑎𝑛𝑠𝑚𝑖𝑡𝑡𝑒𝑑

𝑃𝑖𝑛𝑐𝑖𝑑𝑒𝑛𝑡
) 
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Amplitude – The amplitude of the delay domain data displayed by the OBR is the return loss at 

every data point. Data points are often smaller than physical elements of the DUT (fiber bends, 

lenses, etc.) so the RL of an element will be the summation of the amplitude over all the data points 

in the event. 

 

Measuring RL 

Each datapoint in the delay domain data represents the RL over a small length (<0.1mm). In order to 

characterize the RL for an entire event, the OBR software allows users to integrate the amplitude 

data over a user defined length. The integrated region will be shown in the delay domain plot as a 

highlighted region around the cursor(s). 

 

Figure 5-6 RL measurement using 0.25m RL integration width 

Due to its electrical detection limitations, there is a limit for the difference between the largest and 

smallest reflections that can be observed in a single measurement. This is referred to as the return 

loss dynamic range. When no bright reflections are present, the OBR delay domain data has a noise 

floor (sensitivity) located at -129dB. 
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Figure 5-7 RL dynamic range limitation 

 

 

Measuring IL 

The OBR makes insertion loss measurements by comparing the return loss of the unaltered fiber on 

either side of an event in the delay domain data. The unaltered fiber reflects a small portion of light 

back to the instrument due to the process of Rayleigh scattering. This scattering is uniform over the 

length of standard telecom fibers and does not change in amplitude over time.  

Configure the integration width of the cursors to cover a 0.25m or larger region of the Rayleigh 

scatter. Position the two cursors on either side of the event to be characterized. The IL is shown in 

the upper right corner of the delay domain plot.  

 

Figure 5-8 Insertion loss measurement shown across an APC fiber connector. (IL is shown in upper right corner) 
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The IL shown is the single pass insertion loss. This means it is an estimate of the loss that occurred as 

the light passed through the event in one direction.  

Insertion loss measurements can only be made while the Rayleigh scattering of the surrounding 

fiber is visible. If the scattering on any side of the event is obscured (elevated noise floor, reflection 

peaks, etc.) the IL reading will be incorrect. 

 

 

  

 

 


